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Introducing Using Crystal Reports with Peachtree

Using Crystal Reports with Peachtree

Crystal Reports is included with Peachtree Premium Accounting and above. It lets you 
customize reports using virtually any of the information available in your company 
database. Crystal Reports can be installed from CD 2, which is included in your Peachtree 
package.

Peachtree comes with standard Crystal reports designed with small businesses in mind. 
You can also design your own reports using Crystal Reports' “experts,” which guide you 
step by step through the design process. And if you want to design a special report from 
the ground up, the Report Designer lets you put together text (such as headers or titles), 
maps or graphs, images (such as company logos), and of course database elements just as 
you want them to appear on the printed report. Then you can preview the report to make 
sure it's the way you want it.

Using Crystal Reports in a Network

If you are working with Crystal Reports and Peachtree in a network environment, the 
program needs to be installed on all networked machines where it will be used. The 
program will not work properly if installed on and accessed from a central server.
Important: Consult your license agreement for information about the number of machines on which Crystal Reports can be 
installed.

Give All Users Access to the Program

So that more than one person can have access to Peachtree data and Crystal reports, you 
can copy these to a central server. Say you store your Peachtree data on drive E on the 
server. The data path to your Peachtree data is E:\Program Files\Sage Software\Peachtree, 
and the data path to your company data is C:\Program Files\Sage 
Software\Peachtree\Company\<COMPANY>, where <COMPANY> is the name of the 
folder where your company files are located. You should copy all Crystal reports that 
apply to the company into this folder. Now all machines with access to the data path 
E:\Program Files\Sage Software\Peachtree on the server will have access to both 
Peachtree data and Crystal reports.
Use the "Save As" Option to Save Custom Reports

When Peachtree is installed, the standard Crystal reports are installed as read-only files in 
all company subdirectories. This means that anyone working in Crystal Reports with 
Peachtree will be able to preview the standard Crystal reports but will not be able to edit 
and then save them. That way, you will always have the standard reports in their original 
condition so you can use them as templates for custom Crystal reports.
If you are working in Crystal Reports and try to edit and then save a standard Crystal 
report from Peachtree, you will see an error message stating “This report could not be 



opened for writing. Any changes must be saved to a new file.” If you want to save your 
changes, use the Save As option on the File menu to save the file under a new name. Once 
saved, this new custom report will be fully editable.
Write Access vs. Read-Only Access

When you create new custom Crystal reports based on the standard ones, you will be able 
to edit and save these new reports as desired. However, if more than one person is working 
with the same custom report in Crystal Reports for Peachtree, only the first user to access 
the report will have “write access”—that is, be able to edit and save the report. All other 
users will have read-only access and will be able only to view and print but not save the 
report, whether in preview or in design mode.
Limit Data Access to One User

Through Maintain Users, you can set up user passwords and limit access to areas of the 
Peachtree program. If desired, you can limit access to using Crystal Reports with 
Peachtree, at least for design purposes, to only one user. To give just one user data access 
to Crystal Reports, select the Crystal Reports tab on the Maintain Users screen. Select 
Only one user and choose the user you want to have access from the drop-down list. 
All users will be able to preview or print a Crystal report using the Crystal Reports 
Designer. However, when any user tries to refresh the data in a Crystal report using the 

Refresh button  in the Navigation toolbar, the program will request a password. If the 
password entered does not match the password for the user with Crystal Reports access, 
then the user will not be able to refresh the report data and thus potentially use different 
parameter values to filter the data that appears in the report.
• For more information about the Maintain Users window and setting up users, click the 

Help button in the window. 
• For more information about refreshing report data in Crystal, look up “Refreshing 

data:report data” in the Crystal Reports Online Help index.
Standard Crystal Reports

Peachtree comes with standard Crystal reports specially designed with small businesses in 
mind.

Aged Payables

Aged Receivables

Customer Balance Graph

Customer Detail List

Customer Sales by Item

Customer Sales by Month



Inventory Labels

Items Sold by Month

Purchases by Unit Price

Vendor Balance Graph

Vendor Detail List

Void Check Register

In addition to the pre-defined Crystal reports listed above, Peachtree Premium Accounting 
for Distribution, Peachtree Premium Accounting for Manufacturing, and Peachtree 
Quantum Accounting come with the following pre-defined reports:

Assembly Item UPC_SKU Label

Assembly Planning

Component Pick List

Deficient Components List

Item Sales by Customer and Purchase Order Number

On Hand Detail Report

Production Schedule

Stock Status by Location

Where to Find the Reports

When you install Peachtree, the standard Crystal reports are automatically copied to all of 
your company subdirectories. Also, a Zip file (if you are using Peachtree Premium 
Accounting, this would be PPAReports.zip) containing the reports is automatically copied 
to your \Program Files\Sage Software\Peachtree\Company\Reports directory.

If you alter or delete the original standard reports, you can always Unzip this file and copy 
the reports to your company subdirectory, where you’ll be able to access them in 
Peachtree. In order to Unzip the file, you will need a copy of the WinZip® program 
installed on your computer. You can download an evaluation version of this program from 
the Internet at www.winzip.com.

Note: When you create custom reports or when you download new standard reports from the Peachtree Web 
site, you'll need to copy them to your program subdirectories before you can work with them in 
Peachtree.

www.winzip.com


The Standard Reports

Aged Payables

This report shows a total of aged payables by vendor. It also includes the following 
information for each vendor taken from the Peachtree vendor record:

• Vendor ID

• Vendor Name

• Contact

• Telephone (No. 1)

• Invoice/Credit Memo No.

• Aging Brackets

Aged Receivables

This report shows a total of aged receivables by customer. It also includes the following 
information for each customer taken from the Peachtree customer record:

• Customer ID

• Customer Name

• Contact

• Telephone (No. 1)

• Invoice/Credit Memo No.

• Aging Brackets

Customer Balance Graph

This bar graph shows balances by customer. It also includes basic information for each 
customer taken from the Peachtree customer record. The graph itself shows customer 
balances along the vertical axis and lists customer IDs along the horizontal axis. The 
following information for each customer is listed below the graph:

• Customer ID

• Customer Name

• Contact

• Telephone (No. 1)



• Customer Balance

Customer Detail List 

This report lists detail information about customers you have added to Peachtree through 
Maintain Customers/Prospects, including:

Customer Sales by Item

This report lists stock items sold and the customers sold to within the current accounting 
period. The report is sorted by item rather than by customer and includes the following 
information:

• Inventory ID and Description

• Customer ID

• Date of sale

• Invoice number

• Customer ID and name

• Bill-to and ship-to addresses

• Contact Person

• Phone Number 1 and 2

• Fax Number

• E-mail Address

• Web Address

• Prospect (yes/no)

• Customer status (active/inactive)

• Customer Type

• Customer Since date

• Tax location

• Resale Number

• Open purchase order number

• Credit Limit

• Pricing Level

• GL Sales Account

• Sales Rep Name

• Sales terms

• Sales Tax ID

• Last Invoice Date

• Last Invoice Number

• Last Payment Date

• Last Payment Amount

• Last Statement Date

• A listing of all custom fields



• Quantity sold

Customer Sales by Month

This report lists all customers of your company alphabetically and lists amounts sold to 
them by month. It is based on data contained in the Peachtree Sales Journal.

The report is displayed in cross-tab or spreadsheet format. Along the vertical axis it lists 
customers by ID, and along the horizontal axis it lists all accounting periods covered by 
the report (up to 26 periods).

Inventory Labels

These are labels you place on inventory items so that they can be stocked in the proper 
location at your storage facility. The labels print 3 across x 10 down (30 per page) in the 
LL-30W laser label format available through the Peachtree Business Checks & Forms 
catalog. Each label lists the following information:

• Item ID

• Item description

• Vendor ID

• Location

Items Sold by Month

This report lists, alphabetically by ID, all stock items sold by your company each month. It 
is based on data contained in the Peachtree Sales Journal. 

The report is displayed in cross-tab or spreadsheet format. Along the vertical axis it lists 
items by ID, and along the horizontal axis it lists all accounting periods covered by the 
report (up to 26 periods).

Purchases by Unit Price

This report lists the unit prices of stock and non-stock items purchased and vendors 
purchased from within the current accounting period. The report is sorted by item rather 
than by vendor. Use the report to check which vendors are offering the best pricing on an 
item. The report includes the following information:

• Item ID and description

• Date of purchase

• Vendor ID

• Invoice number



• Quantity

• Unit price

• Total purchase amount

Vendor Balance Graph

This is a bar graph that shows balances by vendor. It also includes basic information for 
each vendor taken from the Peachtree vendor record. The graph itself shows vendor 
balances along the vertical axis and lists vendor IDs along the horizontal axis. The 
following information for each vendor is listed below the graph:

• Vendor ID

• Customer Name

• Contact

• Telephone (No. 1)

• Vendor Balance

Vendor Detail List

This report lists detail information about vendors you have added to Peachtree through 
Maintain Vendors, including:

• Vendor ID and name

• Address

• Contact Person

• Fax Number

• E-mail Address

• Web Address

• Phone Number 1 and 2

• Fax Number

• Vendor Type

• Federal ID Number

• Vendor Since date

• Company account number

• Balance

• Credit Limit

• Purchase Account

• Terms

• A listing of all custom fields



Void Check Register

This report lists all disbursement and payroll checks that have been voided within the 
current accounting period. The report includes the following information:

• Check number

• Void date

• Payee (employee name, vendor name, or customer name)

• Cash account

• Check amount

Assembly Item UPC_SKU Label

Using UPC/SKU (Universal Price Code/Stock Keeping Unit) labels can help you keep 
track of your inventory more accurately. The individual components you purchase from 
vendors may already contain their own UPC/SKU labels. However, you can use the 
Assembly Item UPC_SKU Label report to create labels for the finished products once the 
items are fully assembled. The labels include the following information: 

• Item ID

• Item Description

• UPC/SKU Number

• Location

Assembly Planning

This report displays details for a specified assembly, including the number of components 
needed, available, and on hand for the assembly. This report is helpful if printed before 
beginning the production of an assembly because it provides the status of the necessary 
components. The report includes the following fields: 

• Item ID

• Description

• Quantity Needed

• Quantity on Hand

• Quantity Available



Component Pick List

This report displays an itemized list of the locations and quantities of all components 
required for the specified assembly item. It is helpful to run this report right before you are 
about to assemble an item. The report includes the following fields: 

• Component ID

• Description

• Quantity Needed

• Location

• Initials

Deficient Components List

This report is useful for viewing which bill of material components of an assembly are in 
shortage. By seeing which components you’re missing, you’ll know which components 
you need to order before you can create the assembly. The report shows the following 
fields:

• Component ID

• Description

• Quantity Needed

• Quantity on Hand

• Quantity Available

Item Sales by Customer and Purchase Order Number

This report displays item sales, sorted by customer purchase order number. This report 
was designed to provide an alternate method for looking up sales orders and invoices— 
sorted by the customer, then the customer purchase order number, and then by the sales 
order or invoice number. The report displays the following fields:

• Customer ID

• P.O. Number

• Reference

• Date

• Description



• Item Quantity

• Item Subtotals

On Hand Detail Report

This report displays detailed purchase information for inventory items that have a LIFO or 
FIFO costing method. The information in this report can be used to show how inventory 
has been valued. The On Hand Detail report displays the following fields:

• Item ID

• Item Description

• Receipt Description

• Reference

• Receipt Date

• Quantity

• Unit Cost

• Amount

Production Schedule

This report displays the assembly items on open sales orders, and is sorted by the Ship By 
Date. This report is designed to help you meet shipping deadlines by showing which 
assembly items need to be manufactured, and the order in which they need to be shipped. 
The report displays the following fields:

• Ship By Date

• Sales Order No

• Customer ID

• Customer Name

• Item ID

• Description

Stock Status by Location

This report is similar to Peachtree’s Inventory Stock Status report, but includes the current 
quantities on sales orders and purchase orders in addition to the current quantity on hand. 



It also shows the history of the item (the quantity sold, received, and adjusted in the 
specified date range). The report displays the following fields:

• Location

• Item ID

• Qty Received

• Qty Sold

• Qty Adjusted

• Current Qty on PO

• Current Qty on SO

• Current Qty On Hand

Converting Custom Crystal Reports to New Peachtree Release 
Data Format

If you created reports for Peachtree in Crystal Reports with data in a prior Peachtree 
release and you upgraded Peachtree to a new release, you must do a quick data conversion 
of your customized Crystal reports so that they can properly read data fields introduced or 
modified in the updated Peachtree release. So if you upgrade from one release of 
Peachtree to a newer release, you must convert your customized Crystal reports in order 
for them to be compatible with the new release.

You may also need to follow steps 4 through 10 below if you have upgraded from Crystal 
Reports for Peachtree to Crystal Reports 2008.

Follow these simple steps to update your report data definitions:

1. Install the new version of Peachtree. (You do not have to install a new version of 
Crystal Reports for Peachtree.)

2. In Crystal Reports, open any of your custom Crystal report files (RPT).

3. Make sure they are saved to your new or upgraded Peachtree company data directory 
(for example, \PROGRAM FILES\SAGE 
SOFTWARE\PEACHTREE\COMPANY\<COMPANY>).

• If you installed the new version of Peachtree in the default directory 
(\PROGRAM FILES\SAGE SOFTWARE\PEACHTREE) or installed Peachtree 
in the same location as the previous version, your custom reports are most likely 
saved in the correct company data subfolder.



• If you installed the new version of Peachtree to a new directory, copy or save 
your customized Crystal reports to the new company data subfolder.

4. With your customized report open in Crystal Reports, choose Verify Database from 
the Database menu.

5. Crystal Reports may display a series of Directory error messages. To continue, click 
OK in answer to each of these.

6. If Crystal Reports displays Please give location of Info view or dictionary used to 
create this report, click OK. The Choose Database File window appears. Select 
Crystalreports.udl (located in your new Peachtree company data folder). For 
example, select \PROGRAM FILES\SAGE 
SOFTWARE\PEACHTREE\COMPANY\<COMPANY>\CRYSTALREPORTS.U
DL.

7. Crystal Reports may identify data definition changes associated with your report 
design and ask if you want to update your report. For example, if your report lists 
employee names, you may receive the message, The database file "Employee" has 
changed. Proceeding to fix up the report. Click OK to each of these data definition 
messages.

8. Repeat steps 5 through 7 until you get a message that the database is now up to date.

9. Click OK and the desired report appears in Crystal Reports.

10. Save the updated report. 

11. Repeat steps 4 through 10 for each of your customized reports. Once you have 
updated your reports, they will open normally from Peachtree and Crystal Reports.

Note: You will need access to the Peachtree company data from Crystal Reports to perform the 
steps listed above. If limited access has been set up for accessing company data from 
Crystal Reports through Maintain Users, only the person with access to the company data 
from Crystal Reports can perform these steps. 

Supported Versions of Crystal Reports
Crystal Reports 2008

Peachtree Premium Accounting 2009 and above come with Crystal Reports 2008 on CD 
2. Peachtree also comes with standard reports for Crystal Reports 2008. You will be able 
to view and design new reports through Peachtree using Crystal Reports 2008.

If you have reports created in other versions of Crystal Reports, they will show up in 
Peachtree under Reports & Forms>Crystal Reports. You will be able to view them in the 



Crystal Viewer, but if you want to design them, you will have to open the reports in 
Crystal Reports and not through Peachtree.

Previewing Crystal Reports
Previewing Crystal Reports

The standard Crystal reports that come with Peachtree are designed to open in preview 
mode. This is so you can preview them when you select them either through the Peachtree 
Select a Report or Form window or through Crystal Reports. The Save Data with Report 
option in the Crystal Reports File menu is turned on for each of the standard reports when 
shipped; this is what allows them to be previewed.

Set Up Reports to Appear in Preview Mode

If you turn off the Save Data with Report option and then save a standard report, when 
you open it again either in Peachtree or in Crystal Reports, the report will open in design 
rather than preview mode. So if you want the standard reports to open in preview mode, be 
sure to leave the Save Data with Report option turned on. 

Note: If you turn off Save Data with Report and then save a standard report, when you open it again either in 
Peachtree or in Crystal Reports, the report will open in design rather than preview mode. Set the option 
according to whether you want to see the report each time in preview or design mode.

With the Save Data with Report option turned on, you can preview a Crystal report the 
same way you do other Peachtree reports.

Do one of the following:

• click the name of a Crystal report in the Select a Report or Form window, and then 
click the Display button.

• double-click the report name with the left mouse button.
The report will appear on the Preview tab of the Crystal Reports window.
For more information on using the Crystal Reports Preview tab, look up “Preview Tab” in 
Crystal Reports Online Help. 

Data Dictionary Files (DDFs)
List of Data (.DAT) Files Available in Peachtree for Crystal 
Reports, OLEDB, and ODBC

The following is a list of all data (.DAT) files that are included in Peachtree This 
information is intended to assist those who design reports for Peachtree using Crystal 
Reports.



To see the field information included in the .DAT files listed below, look up ".DAT files; 
listed" in the Peachtree Help index. From that topic, you can click on the name of a .DAT 
file to see the field information that is included in that file.

Note: The list below does not constitute a list of each file in your Peachtree company data directory. It contains 
only the data tables that can be accessed via crystalreports.udl, which were specifically designed for 
using Crystal Reports with Peachtree.

ADDRESS.DAT Address Fields
AUDITTR.DAT Audit Trail Fields (Peachtree Complete 

and higher only)
BOMHIST.DAT

BOMITEMS.DAT

Bill of Materials Fields (Peachtree 
Premium Accounting for Distribution, 
Peachtree Premium Accounting for 
Manufacturing, and Peachtree 
Quantum only)

BDETAIL.DAT Budget Detail Fields
BUDGET.DAT Budget Fields
CASHFLOWMANAGER.DAT Cash Flow Manager Fields (Peachtree 

Complete Accounting and higher only)
CHART.DAT Chart of Accounts Fields
COMPANY.DAT Company Fields
CONTACTS.DAT Contact fields
COSTCODE.DAT Cost Code Fields (Peachtree Complete 

Accounting and higher only)
CUSTOMER.DAT Customer Fields
EMPLOYEE.DAT Employee Fields
GENERAL.DAT_AP Vendor and Accounts Payable Default 

Information Fields
GENERAL.DAT_AR Customer and Accounts Receivable 

Default Information Fields
GENERAL.DAT_GL General Ledger Default Information 

Fields
GENERAL.DAT_INV Inventory Default Information Fields
GENERAL.DAT_JOBS Job Default Information Fields
JRNLHDR.DAT Journal Header Fields
JRNLROW.DAT Journal Row Fields
JRNLSNO.DAT Serial Number Fields (Peachtree 

Premium Accounting and higher only)
JOBEST.DAT Job Estimates Fields
LINEITEM.DAT Inventory Item Fields
NOTADMSG.DAT Notification Additional Message Fields 

(Peachtree Quantum Accounting only)
NOTCDVAL.DAT Notification Condition Fields  

(Peachtree Quantum Accounting only)
NOTIFICA.DAT Notification Fields (Peachtree Quantum 

Accounting only)
NOTRECIP.DAT Notification Recipient Fields (Peachtree 

Quantum Accounting only)
NOTMSG.DAT Notification Message Fields (Peachtree 

Quantum Accounting only)



Note: Not all Peachtree database information is available or presented in Peachtree field tables. For example, 
Employee default information (Payroll setup), action items, and Peachtree company user setup (user IDs 
and passwords) cannot be added to your Crystal reports. You may be able to access data fields that 
would not be pertinent for your reports (for example, fields used in internal Peachtree functions).

Also, some Peachtree fields (which cannot be described in Peachtree data [.DAT] files) require custom 
formulas in order to extract data for reports. 

Peachtree Functions in Crystal Custom Formulas
Some Peachtree fields—ones that can't be described in Peachtree data [.DAT] files—require custom formulas in order to 
extract data for reports. The fields listed below fall into this category. If you need the additional information contained in 
these special fields while designing reports in Crystal Reports, use the functions listed below in your custom report 
formulas. 

NOTRULES.DAT Notification Rules Fields (Peachtree 
Quantum Accounting only)

PHASE.DAT Phase Fields (Peachtree Complete and 
higher only)

PROJECT.DAT Job Fields
QTYDISC.DAT Quantity Discount Fields (Peachtree 

Premium Accounting for Distribution, 
Peachtree Premium Accounting for 
Manufacturing, and Peachtree 
Quantum only)

RAISEHST.DAT Raise History Fields
REVIEW.DAT Performance Review Fields (Peachtree 

Complete Accounting and higher only)
STATCODE.DAT Tracking Status Code Fields (Peachtree 

Quantum Accounting only)
STATHIST.DAT Tracking Status History Fields 

(Peachtree Quantum Accounting only)
STATNOTE.DAT Tracking Status Note Fields (Peachtree 

Quantum Accounting only)
TAXAUTH.DAT Sales Tax Authority Fields
TAXCODE.DAT Sales Tax Code Fields
TICKET.DAT Time/Expense Ticket Fields (Peachtree 

Complete Accounting and higher only) 
UNITMEAS.DAT Unit/Measure Fields (Peachtree 

Premium Accounting for Distribution, 
Peachtree Premium Accounting for 
Manufacturing, and Peachtree 
Quantum only)

VENDINS.DAT Vendor Insurance Fields Peachtree 
Premium Accounting for Construction 
and Peachtree Quantum only)

VENDOR.DAT Vendor Fields
WORKTKT.DAT Work Ticket Fields (Peachtree 

Premium Accounting for Distribution, 
Peachtree Premium Accounting for 
Manufacturing, and Peachtree 
Quantum only)



Note: Reports containing these custom formulas must reside in the same directory as your Peachtree company 
files. This is so the reports can extract data directly from the company information contained in the files. 

An Important Additional Note: 

If you are working with Crystal on a computer where no previous versions of Peachtree 
and Crystal Reports have been installed, the special Peachtree functions need to be loaded 
into Crystal Reports. Otherwise, they will not be present for use in the reports you are 
designing.

To load the Peachtree functions into Crystal, follow these steps:

1. Open Peachtree and then a Peachtree company.

2. From the Reports & Forms menu, select Crystal Reports.

3. Select any report in the list, and double-click it.

The report opens in Crystal Reports.

4. Close both the report and Crystal Reports.

5. In Peachtree, from the Reports & Forms menu, select Crystal Reports Designer.

Now when you design a new report in Crystal Reports, all Peachtree functions will appear 
in the Crystal Formula Editor.

How To Access Custom Formulas in Crystal Reports

Do the following:

1. From the Standard Toolbar, select the Field Explorer button .

2. In the Fields Explorer window, select Formula Fields.

3. To create a new formula field, click the New button ( ).

4. Enter a name, such as “Amount,” and click OK.

The Crystal Reports Formula Editor appears.

5. To access the Peachtree functions, click Functions in the middle pane, and then 
double-click Additional Functions. 

6. Find and double-click peach (u2lpeach.dll).

The Peachtree functions listed below should appear.



Custom Field Names

GetPeachCustomFieldHeadingv2 ({Company.CompanySpecial1a}, {Company.CompanySpecial1b}, {Company.CompanySpecial1c}, 

{Company.CompanySpecial1d}, AR=1 AP=2 PR=3 Inventory=6 Jobs=7, (Index 0..4))

The appropriate format for the function is suggested by the displayed text. For example, in 
order to return the custom field headings for customers, you would create five formulas, 
each for a different heading. The function should read

GetPeachCustomFieldHeadingv2 ( Filename, 1, 0)

This returns the first customer custom field heading. (Most indexes with Peachtree fields 
begin with zero_

GetPeachCustomFieldHeadingv2 ( Filename, 1, 1)

This returns the second customer custom field heading. Follow the same format for the 
three remaining formulas.

Tip: To view an example of this function, examine the Customer Detail List or the Vendor Detail List which are 
Crystal Reports included with Peachtree.

Inventory Costing Row Amount

GetPeachRowAmountv2 ({Company.CompanySpecial1a}, {Company.CompanySpecial1b}, {Company.CompanySpecial1c}, 
{Company.CompanySpecial1d}, {JrnlRow.RowType}, {JrnlRow.Amount}, {JrnlRow.Journal}, {JrnlRow.PostOrder}, 

{JrnlRow.RowNumber}, {JrnlRow.RowDate}, {JrnlRow.ItemRecordNumber}, {Company.IsCashBasis})

This returns appropriate row amounts for cost of sales rows. In the raw data, the cost of 
sales mount is not necessarily accurate, as the real cost of sales is based on a calculation. 
The JrnlRow table is required to use this function in a report.

Price Level Name

GetPeachPriceLevelNamev2 ({Company.CompanySpecial1a}, {Company.CompanySpecial1b}, {Company.CompanySpecial1c}, 

{Company.CompanySpecial1d}, (Index 1..20))

This function returns one of the 20 price level names listed in Inventory Item Defaults, the 
Price Levels tab. When using the function, be sure to replace the string "(Index 1.20)" 
with the desired number from 1 to 20. In order to use this function, you must include the 
LineItem table in your report.

Beginning Balance (Quantity)

GetPeachItemBegBalv2 ({Company.CompanySpecial1a}, {Company.CompanySpecial1b}, {Company.CompanySpecial1c}, 

{Company.CompanySpecial1d}, {LineItem.ItemRecordNumber})

This function returns the quantity on hand at the beginning of the current accounting 
period for the item specified. The function requires that you use the LineItem table.



Quantity on Hand

GetPeachItemQtyOnHandv2 ({Company.CompanySpecial1a}, {Company.CompanySpecial1b}, {Company.CompanySpecial1c}, 

{Company.CompanySpecial1d}, {LineItem.ItemRecordNumber})

This function is similar to GetPeachItemBegBal except that it returns the quantity on hand 
at the end of the current accounting period. It is the same number shown in Maintain 
Inventory Items in the Qty on Hand field. The function requires that you use the LineItem 
table.

Quantity on PO's

GetPeachItemQtyOnPOv2 ({Company.CompanySpecial1a}, {Company.CompanySpecial1b}, {Company.CompanySpecial1c}, 

{Company.CompanySpecial1d}, {LineItem.ItemRecordNumber})

This function returns the quantity of the specified item on open purchase orders. It is the 
same number shown in Maintain Inventory Items in the Qty on PO's field. The function 
requires that you use the LineItem table.

Quantity on SO's

GetPeachItemQtyOnSOv2 ({Company.CompanySpecial1a}, {Company.CompanySpecial1b}, {Company.CompanySpecial1c}, 

{Company.CompanySpecial1d}, {LineItem.ItemRecordNumber})

This function returns the quantity of the specified item on open sales orders. It is the same 
number shown in Maintain Inventory Items in the Qty on SO's field. The function 
requires that you use the LineItem table.

Last Cost

GetPeachItemLastCostv2 ({Company.CompanySpecial1a}, {Company.CompanySpecial1b}, {Company.CompanySpecial1c}, 

{Company.CompanySpecial1d}, {LineItem.ItemRecordNumber})

This function returns the same number shown in Maintain Inventory Items in the Last 
Unit Cost field. The function requires a LineItem record. The function requires that you 
use the LineItem table.

Current Period Start Date

GetPeachCurrentPeriodStart

This function returns the start date of the current accounting period.

Current Period End Date

GetPeachCurrentPeriodEnd

This function returns the end date of the current accounting period.



Selected Period Start Date

GetPeachPeriodStart

This function returns the start date of the accounting period selected by index number 
within the function

GetPeachPeriodStart(Filename, (Index 1..40) )

For example, the function 

GetPeachPeriodStart(Filename, 40)

would return the start date of period 26 in the case of fiscal years set up with thirteen 
periods.

Selected Period End Date

GetPeachPeriodEnd

This function returns the end date of the accounting period selected by index number 
within the function:

GetPeachPeriodEnd(Filename, (Index 1..40) )

For example, the function

GetPeachPeriodEnd(Filename, 40)

would return the end date of period 26 in the case of fiscal years set up with thirteen 
periods.

Estimated Job Expenses

GetPeachEstJobExpensev2

This function returns the total estimated job expenses seen on the Maintain Jobs window. 
The function requires that you use the Projects table.

Estimated Job Revenue

GetPeachEstJobRevenuev2

This function returns the total estimated job revenue seen on the Maintain Jobs window. 
The function requires that you use the Projects table.

Actual Job Expenses

GetPeachActualJobExpensev2



This function returns the total actual job expenses seen on the Maintain Jobs window. The 
function requires that you use the Projects table.

Actual Job Revenue

GetPeachActualJobRevenuev2

This function returns the total actual job revenue seen on the Maintain Jobs window. The 
function requires that you use the Projects table.

Actual Job Expenses by Period

GetPeachThisPeriodActualJobExpensev2

This function returns the total actual job expenses for the chosen period. The function 
requires that you use the Projects table.

Actual Job Revenue by Period

GetPeachThisPeriodActualJobRevenuev2

This function returns the total actual job revenue for the chosen period. The function 
requires that you use the Projects table.

Account ID

GetPeachGLAccountIDv2

This function returns the general ledger account ID for the account with the account 
record number specified in the function.

Account Description

GetPeachGLAccountIDv2

This function returns the general ledger account description for the account with the 
account record number specified in the function.

Time Stamp Date

GetPeachTimeStampDatev2

This function returns the date of the time stamp for a particular row in the Audittr.DAT 
table.

Note: Users must be set up in Maintain Users with sole rights to Crystal Reports in order to access information in 
the Audittr.DAT table.

Time Stamp Time

GetPeachTimeStampTimev2



This function returns the time of the time stamp for a particular row in the Audittr.DAT 
table. 

Note: Users must be set up in Maintain Users with sole rights to Crystal Reports in order to access information in 
the Audittr.DAT table.

Company Information Functions

These functions, which are self-explanatory, return company information as entered in the 
Peachtree Maintain Company Information window. The functions include the following:

Bill of Material (BOM) Functions

All bill of material functions discussed below require that you use the LineItem table.

Assembly Component

GetPeachBOMCompIDv2

This function returns the ID of a component used in an assembly based on the index 
specified in the function. In this function, the numbered index of assembly components 
starts with zero. The function is displayed as follows:

GetPeachBOMCompIDv2 (Filename, {LineItem.ItemRecordNumber}, (Index 0..99) )

To return the desired component ID, you must replace "Index 0..99" with the appropriate 
number from 0-99. For example, to return the first component in the assembly, the 
function should read

• GetPeachCompanyNamev2

• GetPeachAddress1v2

• GetPeachAddress2v2

• GetPeachCityv2

• GetPeachStatev2

• GetPeachZIPv2

• GetPeachCoutryv2

• GetPeachFEINv2

• GetPeachIsCashBasisv2

• GetPeachISRealTimePostv2

• GetPeachCompanyTypev2

• GetPeachEmailv2

• GetPeachWebSitev2

• GetPeachPhoneNumberv2

• GetPeachFAXNumberv2

• GetPeachSEINv2

• GetPeachSUINv2



GetPeachBOMCompIDv2 (Filename, {LineItem.ItemRecordNumber}, 0 )

Use the index field in a similar manner for all BOM functions.

Assembly Component Description

GetPeachBOMCompDesv2

This function returns the description of a component used in an assembly based on the 
index specified in the function.

Required Number of an Assembly Component

GetPeachBOMCompReqv2

This function returns the number of units of an individual component required to build the 
assembly.

Quantity on Hand of an Assembly Component

GetPeachBOMComponHandv2

This function returns the quantity on hand of an individual component used in the 
assembly.

Quantity Available of an Assembly Component

GetPeachBOMCompAvailv2

This function returns the quantity available of an individual component used in the 
assembly. The quantity available is calculated as the amount on hand plus the quantity on 
all purchase orders minus the quantity on all sales orders.

Location of an Assembly Component

GetPeachBOMCompLocv2

This function returns the storage location in your facility of an individual component used 
in the assembly.

UPC/SKU of an Assembly Component

GetPeachBOMCompUPCv2

This function returns the UPC/SKU value of an individual component used in the 
assembly.

Sales Description of an Assembly Component

GetPeachBOMCompSalesDesv2



This function returns the sales description (as noted in the Maintain Inventory Items 
window) of an individual component used in the assembly.

Purchase Description of an Assembly Component

GetPeachBOMCompSalesDesv2

This function returns the purchase description (as noted in the Maintain Inventory Items 
window) of an individual component used in the assembly.

Last Cost of an Assembly Component

GetPeachBOMCompLastCostv2

This function returns the last cost (as noted in the Maintain Inventory Items window) of an 
individual component used in the assembly.

Assembly Revision Number 

(Available only in Peachtree Premium Accounting for Distribution and Peachtree 
Premium Accounting for Manufacturing.)

GetPeachRevisionNo

This function returns the current revision for an assembly.

Serial Number Functions

All Serial Number functions are available only in Peachtree Premium Accounting.

Status of Serial Number

GetPeachSNoStatus

This function returns the current status of the serial number using status text that is 
displayed in Maintain Inventory Items. You will be required to provide the file path and 
name, the item record number, and the serial number.

Warranty Expiration Date

GetPeachSNoWarDate

This function returns the expiration date. If the item is not covered under warranty, the 
field will be returned blank.

Work Ticket Functions

All Work Ticket functions are available only in Peachtree Premium Accounting for 
Distribution and Peachtree Premium Accounting for Manufacturing.



Assembly Component's Item ID

GetPeachWTCompID ( Filename, {Worktkt.RecordNumber}, 
ComponentIndex (1-300 ) ) 

This function gets the component ID for a row on a particular work ticket.

Assembly Component's Description

GetPeachWTCompDes( Filename, {Worktkt.RecordNumber}, 
ComponentIndex (1-300 ) ) 

This function gets the component’s description for a row on a particular work ticket.

Assembly Component's Quantity On Hand

GetPeachWTCompOnHand( Filename, {Worktkt.RecordNumber}, 
ComponentIndex (1-300 ) ) 

This function gets the component’s Quantity On-Hand for a row on a particular work 
ticket.

Assembly Component's Quantity Available

GetPeachWTCompAvail( Filename, {Worktkt.RecordNumber}, 
ComponentIndex (1-300 ) ) 

This function gets the component’s Quantity Available for a row on a particular work 
ticket.

GetPeachWTCompLoc( Filename, {Worktkt.RecordNumber}, 
ComponentIndex (1-300 ) ) 

This function gets the component’s location for a row on a particular work ticket.

Assembly Component's UPC

GetPeachWTCompUPC( Filename, {Worktkt.RecordNumber}, 
ComponentIndex (1-300 ) ) 

This function gets the component’s UPC for a row on a particular work ticket.

Assembly Component's Sales Description

GetPeachWTCompSalesDes( Filename, {Worktkt.RecordNumber}, 
ComponentIndex (1-300 ) ) 

This function gets the component’s Sales description for a row on a particular work ticket.



Assembly Component's Purchase Description

GetPeachWTCompPurchDes( Filename, {Worktkt.RecordNumber}, 
ComponentIndex (1-300 ) ) 

This function gets the component’s Purchase description for a row on a particular work 
ticket.

Unit/Measure Functions

All Unit/Measure functions are available only in Peachtree Premium Accounting for 
Distribution and Peachtree Premium Accounting for Manufacturing.

Unit/Measure ID

GetPeachUMID

This function returns the Unit/Measure ID.

Unit/Measure Description

GetPeachUMDescription

This function returns the Unit/Measure Description.

Designing Crystal Reports: A Tutorial
Designing Crystal Reports

When you design a Crystal report, you can either manually select the elements that go into 
the report or let one of the Crystal Report Experts automate the process for you. Report 
Experts guide you step by step through the design process, so they are a good choice if you 
are new to report design. For information on using Report Experts, look up "experts" in 
the Crystal Reports Online Help index.

Once you get a better handle on the design process, you can manually construct your 
report using Crystal’s Database Expert, Select Expert, Formula Expert, Section Expert, 
and Format Editor to choose exactly which data elements and formatting you want to 
include. For information on using any of these features, look up the name of the specific 
feature in the Crystal Reports Online Help index.

The Crystal Reports for Peachtree Tutorial

Crystal Reports Online Help will give you detailed instructions on report design. 
However, to introduce you to the process, we would like to offer a brief tutorial that will 
give you practice customizing two of the standard Crystal reports that come with 



Peachtree, as well as designing a new Crystal report from scratch. Among other things, 
you'll learn how to use the Fields Explorer to insert fields into your reports.

When you've completed the tutorial, you'll better understand how to make your Crystal 
reports provide just the data you want them to, in the format you prefer.

The tutorial contains the following lessons:

• Lesson 1: Modifying Inventory Labels to Create Price Tags. In this lesson you 
learn how to save one of the standard Crystal reports in an editable version and then 
modify the formatting and fields in the report to meet special needs.

• Lesson 2: Designing a Customer Contact List. This lesson tells you how to build a 
simple report that will help you stay in touch with customers. In this lesson, we'll build 
the report from the ground up.

• Lesson 3: Designing a Quotes Good Through List. The third lesson tells you how to 
use the Crystal Standard Report Creation Wizard to put together a more complex 
report, one that lists quotes issued to customers by expiration date.

The tutorial also contains two appendices that have useful additional information.

• Appendix 1: Adding Database Information to a Crystal Report. This provides 
basic instructions on using the Crystal Database Expert to select and meaningfully link 
database tables so that desired information from the Peachtree databases appears in 
your reports.

• Appendix 2: Filtering Crystal Report Data. This gives you tips on filtering database 
information to further limit the data that appears in your Crystal reports.

Lesson 1: Modifying Inventory Labels to Create Price Tags

The first lesson in the tutorial is a warm-up exercise in which we customize one of the 
standard Crystal reports. We’ll turn the inventory labels into price tags that can be 
attached to sale merchandise.

Use “Save As” to Create a Working Version of the Report

Since the standard reports are read-only versions (you can’t edit them in any way), we 
need to create an editable version of the inventory labels.

1. If Crystal Reports isn’t currently running on your computer, start it now.

2. Select File>Open, and then navigate to the BCS folder in the Program Files\Sage 
Software\Peachtree\Company directory; this is where Bellwether Garden Supply 
company data is located. 



3. From the reports listed in the Open window, select Inventory Labels.

4. A message appears telling you that you cannot write to (edit) the report. Click OK.

5. To save the report in editable form, from the File menu, select Save As.

6. In the File name box, enter “Price Tags.” (Crystal Reports will automatically add the 
needed .rpt extension.) Then select Save.

7. Close the report.

8. Go to File>Open and reopen the "Price Tags" report.

Modify the Labels to Create Price Tags

We’re now ready to start working on our modified version.

1. Select the Design tab.

2. We won’t need the Vendor ID or Location fields, so place the cursor in the blue area 
that reads “Details d” and right-click.

3. From the pop-up menu, select Delete Section.

4. We want to keep the section marked “Details c,” so we'll delete just the Vendor ID 
field. With the mouse cursor, select the field.

An object frame appears around the field, and the cursor turns into a cross with four 
arrowheads. The field is now editable.

5. Right-click, and from the pop-up menu, select Delete.

The field is deleted.

6. Select the Field Explorer button  in the Standard toolbar.

7. In the Field Explorer, double-click the Database Fields folder to open it, and then 
double-click the LineItem table to open it.



8. Find the PriceLevel1Amount field; select it; and drag it into the Detail c section. 
Release the mouse button.

9. Close the Field Explorer window.

10. Now we want to modify the font used for the ItemDescription field. Select the field, 
and then right mouse click.

11. From the pop-up menu that appears, select Format Field.

12. Select the Font tab.

13. From the Style drop-down list, select Bold.

14. Click OK.

15. Now let’s change the font of the PriceLevel1Amount field. Select it, and right 
mouse click. Select Format Field.

16. Select the Font tab.



17. Use the Font drop-down list to select Arial.

18. Use the Style drop-down list to select Bold.

19. Use the Size drop-down list to select 16 points.

20. Use the Color drop-down list to select Red.

21. Click OK.

22. Use the frame handles (small blue squares located around the frame) to resize the 
object so that you can read more of the object name. 

23. Next we want to insert an “Our Price” marker. Select the Insert Text Object button 

 in the Insert Tools toolbar. Notice the cursor appears as a plus sign. 

24. Place the cursor at the far left side of the Details c section, hold the left mouse button 
down and drag the text box to the right. 

25. A text cursor appears at the right side of the object frame. Type in the following: 
“Our Price: $.”

26. Click outside the object frame, and then right-click it. From the pop-up menu select 
Format Text and select the Font tab. Now make the font settings exactly as in steps 
17 through 20. Click OK.

27. The text will probably appear a bit cut off at the bottom, so select the bottom frame 
handle (the small blue square at the bottom of the frame), and drag it downward until 
you can see the text plainly.

28. Select the object frame, and move it up so that it more or less aligns with the 
PriceLevel1Amount field.

29. To make more precise adjustments, we need to go to the Preview tab.

30. Our labels look pretty good already, but we need to make a couple of adjustments 
First we need to move the PriceLevel object to the right. Select the first 



PriceLevel1Amount object frame and move it to the right so that you have enough 
room to display the "Our Price" object frame. 

31. Next we need to expand the “Our Price” object frame so that the entire label is 
shown, making sure that there is a slight space between the “Our Price” object 
frame and the PriceLevel1Amount object frame. Select the first “Our Price” object 
frame in the window. When the frame handles appear, click on the one at the right 
side of the frame, and drag the frame to the right.

32. The “Our Price” field is rather far away from the dollar sign, so let’s close up the 
space. Select the PriceLevel1Amount field (in the illustration above, it would be the 

79.99 value). When the object frame appears, click the Align Left button  in the 
Formatting toolbar at the top of the window. 

This way, if the PriceLevel1Amount field has a large value in it (1,000.00 or more), 
the field will expand to the right to accommodate the longer string of numbers. Our 
price tags are now complete.

33. Finally, from the File menu, select Save As, and save the report under the name 
“Price Tags.”

Review of Lesson 1

Let’s review some of the ideas we covered in Lesson 1:

Since the standard Crystal reports that come with Peachtree are read-only, if you want 
to customize one of the reports, you must first save it under a new filename.

When you are working with data fields within a report, select them and right click to 
see a pop-up menu that lets you format, delete, and copy fields, as well as perform 
other functions.

To insert data fields, use the Field Explorer button in the Standard toolbar. To insert 
text fields, use the Insert Text Object button in the Insert Tools toolbar.



To move a field, first select it. The cursor will change into a cross with four 
arrowheads, indicating that you can now manipulate the frame. To move the 
frame, simply drag and drop it. 

To expand or contract an object frame, select the frame; click the appropriate frame 
handle (at either right, left, top, or bottom of the frame); and then drag and release 
the frame.

Lesson 2: Designing a Customer Contact List

The second lesson in the tutorial covers the design of a contact list you can use to help 
keep track of your customer base. It will list customer company name, contact name, and 
phone number.

Select the Report Database

First we need to select the tables whose database information we’ll use to build the report.

1. If Crystal Reports isn’t currently running on your computer, start it now. 

2. Select File>New>Blank Report.

3. In the Database Expert, double-click Create New Connection and then click the + 
sign next to the OLE DB (ADO) folder.

4. Select the Use Data Link File checkbox.

5. In the Microsoft Data Link File field, browse to your company folder and select 
Crystalreports.udl.

6. Click Next, then Next, and then Finish.

7. From the list of displayed tables, select Customers; either double-click it or select 

the Right Arrow button .

8. When finished, select OK.

9. From the Standard Toolbar, select Field Explorer.

Select and Insert Fields

Now we want to place the appropriate fields in exactly the right spots within the report.

1. In the Field Explorer, double-click Database Fields and then Customers.

2. From the list of customer fields, select CustomerID, and then drag it to the far left of 
the Details section of the Report Designer. 



An object frame with the cursor shaped like an arrow appears as you drag the field.

3. To insert the field, release the mouse button.

Note the following:

The object frame indicates that when the report is either printed or previewed, 
the field value will appear where the field name now appears.

The width of the object frame indicates the maximum allowable width of the 
printed or previewed field. It is set to display the maximum number of 
characters in the field, but you can change this by resizing the object frame.

The field name is repeated above, underlined, in the Page Header section. 
This represents the column header text for the field and is how the header 
will appear on the printed or previewed report.

The font and style used in displaying both the field value and the column 
header indicate the font and style selected for the characters that appear in 
both these elements. Later, we’ll tell you how to change the font and style 
of text characters.

4. Now we want to add two additional fields to the report. In the Field Explorer 
window, select the Contact field; press the Ctrl key; and then select the 
Phone_Number field. Drag the fields and place them to the right of the CustomerID 
field.

As you drag the fields, an object frame appears with the cursor shaped like an arrow 
atop stacked sheets of paper marked with a plus. This indicates that you are inserting 
multiple fields at once.

5. Click the mouse button to insert the fields.

The fields appear in the same order in which you selected them in the Field Explorer 
window, namely, Contact followed by Phone_Number

6. Next we want to place the company name at the top of the report. In the Field 

Explorer window, select Formula Fields, and then select the New button.



The Formula Name window appears.

7. Type in "Company Name," and then select the OK button.

The Formula Editor appears.

8. In the middle panel, double-click the Functions icon to expand the list of function 
categories. Find and double-click Additional Functions to further expand the list.

9. Find and double-click the peach (u2lpeach.dll) icon.

This expands the list to display the list of custom Peachtree functions. The functions 
marked "v2" are Crystal Report for Peachtree Version 9 custom functions. These 
functions will work with Crystal Reports 2008.

10. Double-click the function GetPeachCompanyNamev2.



This is the function that will display the company name when placed in a formula and 
then applied to a report.

11. Select the Save and close button  in the upper left corner of the 
Formula Editor.

The Company Name formula appears in the list of formulas in the Field Explorer 
window.

12. Drag the Company Name formula field to the Report Header section, and click to 
place it at the top of the section, centering it within the section.

The field name aligns with the left side of the object frame.

13. To center the field name so that the company name is centered on the printed or 

previewed report, select the object frame and then select the Align Center button  
in the Formatting toolbar.

The formula name is now centered in the object frame, indicating that the formula 
will be centered on the printed or previewed report.

Title and Preview the Report

Finally, we want to add a title to the report. To do so, we’ll need to slightly increase the 
size of the Report Header section. 



1. Place the cursor on the dividing line between the Report Header and Page Header 
sections.

The cursor now has double arrows, indicating that you can use it to move the divider 
between sections.

2. Hold down the left mouse button, and move the dividing line down perhaps a quarter 
of an inch, just enough to insert the report title.

3. To insert the title, click the Insert Text Object button  in the Insert Tools 
toolbar. The cursor turns into a plus sign. Select the area below Company Name, 
hold the left mouse button down, and drag the object frame to the right so that it is 
located below Company Name.

An object frame appears with the text cursor at the left side of the frame.

4. In the object frame, type “Customer Contact List.”

5. Next, let’s center the title just as we did the Company Name formula. Select the 

object frame around the report title, and then click the Align Center button .

The text appears centered within the object frame.

6. Now we want to change the font and style of the report title. Select the object frame 
around the title, and then right mouse click.

7. From the pop-up menu that appears, select Format Text.

8. Select the Font tab.

9. From the Style drop-down list, select Bold.

10. From the Size drop-down list, select 18 points.

11. From the Color drop-down list, select Maroon.

12. When finished, select OK.

13. Use the blue frame handles to resize the field so that the whole title is visible.



14. The title will be a bit off center, so select the object frame; drag it to center it; and 
then release the mouse button.

15. Before you preview the report, you need to save it so that the formulas will work 
correctly. Go to File>Save As and save the report with the name "Customer Contact 
List".

16. Now let’s preview the report to make sure it will look all right when printed. Do one 
of the following: 

• From the View menu, select Print Preview.

• From the Navigation Tools toolbar, select the Refresh button .

A new tab, the Preview tab, appears. It shows how the report will look in printed 
form.

To make any desired changes such as changing the placement of fields for a more 
esthetically pleasing effect, select the Design tab, and work with the fields there. As 
you learned in Lesson 1, it’s possible to change report elements on the Preview tab, 
but it’s generally easier working on the Design tab.

17. Finally, if you made any additional changes, from the File menu, select Save As, and 
save the report under the name “Customer Contact List.”

Review of Lesson 2

Let’s review some of the ideas we covered in Lesson 2:

Use the Database Expert window to connect with the file that contains the database 
tables you want in your report. Use this window also to find and select the tables 
you want to include.

To add fields to the table, use the Field Explorer to find and select the appropriate 
fields within the included database tables. You can select multiple fields by 
highlighting the fields and then selecting the Ctrl button. 

To resize any of the sections in the report, just select the section divider, and holding 
down the left mouse button, drag the divider to the position you want.

To center text within an object frame, use the Align Center button.



To add text to the report, use the Insert Text Object button

To change the font properties of a text object, select the object and right mouse click. 
From the pop-up menu, select Format Text. Select the Font tab and make the 
appropriate changes.

To preview a report before printing, select Print Preview from the File menu, or 
select the Refresh button in the Navigation Tools toolbar.

Lesson 3: Designing a Quotes Good Through List

In this lesson we design a list of quotes issued to customers arranged by good-through 
(quote expiration) date. The report will list the initial date of the quote, the customer, the 
quote amount, and the good-through date.

To show more of the design capabilities of Crystal Reports for Peachtree, this time we’ll 
let the Report Expert guide us.

Use the Report Expert to Build the Report

1. From the File menu in Crystal Reports, select New>Standard Report.

The Standard Report Creation Wizard starts with the Data window.

2. Double-click the Create New Connection folder to open it, and then click the + sign 
next to OLE DB (ADO).



3. Select the Use Data Link File checkbox.

4. In the Microsoft Data Link File field, browse to your company folder and select 
Crystalreports.udl.

5. Click Next, then Next, and then Finish.

6. From the list of displayed tables, select JrnlRow. Then select the Right Arrow 

button .

JrnlRow appears in the Selected Tables box on the right.

7. Repeat step 7 for the JrnlHdr and Customers tables.

8. When finished, select Next.

The Link window appears, asking that you link the tables as needed. 

9. Smart Linking attempts to link tables, but it may not always be the way you want it. 
In this case, we need to clear the links and redo them.

10. Click Clear Links. Click Yes on the message asking if you want to remove all of the 
links.

11. Click Auto-Arrange. you'll probably want to make the window larger so you can see 
all the tables.

12. Move JrnlRow to the right and move JrnlHdr and Customers so they are aligned 
vertically to the left of JrnlRow.

13. Locate the PostOrder field in both the JrnlHdr and JrnlRow tables.

14. Using the mouse, click on the PostOrder field in the JrnlHdr table and while 
holding down the left mouse button, move to the PostOrder field in the JrnlRow 
table. Release the mouse button.



Notice an arrow appears showing the link between the two tables.

15. Locate the CustomerRecordNumber field in the Customers and JrnlRow tables.

16. Using the mouse, click on the CustomerRecordNumber field in the Customers 
table and while holding down the left mouse button, move to the 
CustomerRecordNumber field in the JrnlRow table. Release the mouse button.
Notice an arrow appears showing the link between the two tables.

17. Click Next.

The Fields window appears.

18. In the Available Fields box, double-click the Customer table if it is not already open. 

Select the CustomerID field, and then click the Right Arrow button .

The CustomerID field moves to the Fields to Display box at the right side of the 
window.

19. In the Available Fields box, double-click the JrnlHdr table to open it. Press the Ctrl 
key, and select the TransactionDate, MainAmount, GoodThruDate, and 

QuoteIDForSales field, and then click the Right Arrow button .

20. Use the Up and Down Arrow buttons  above the Fields to Display box to 
place the fields in the following order (if they aren’t already):

• GoodThruDate

• CustomerID

• QuoteIDForSales

• TransactionDate



• MainAmount

21. When finished, select the Next button.

The Grouping window appears.

22. We want to group our data by the GoodThruDate field, so select it in the Available 

Fields box, and then click the Right Arrow button .

23. The preselected sort order is acceptable, so select the Next button.

24. We want to include summary information to appear on our report, and the Summaries 
window lets us do this. The Wizard has intelligently preselected the MainAmount 
field as the field to summarize. This is acceptable, so select the Next button.

25. The Group Sorting window lets us sort groups based on summarized totals. This 
could be useful if we wanted to see, for example, which sales rep made the most sales 
in a month, but for our current report sorting is not important. So select the Next 
button without making any changes to the settings.

Now, the Chart window appears. 



26. Again, a chart would be valuable for visually representing sales per sales rep or per 
geographic area, but for our report charting is not important. So select Next without 
choosing a chart option.

The Record Selection window appears.

27. We want to make sure that only quotes appear in our report. To do so, in the 
Available Fields box, double-click the JrnlHdr table to open it. In this list of fields, 
select JrnlKey_Journal. This will tell Crystal that of all the company information 
contained in the journal header file, we want only quote information to appear in the 

report. Click the Right Arrow button .

28. From the drop-down list immediately underneath the Filter Fields box, select is 
equal to. And in the other drop-down list box that appears, type 12.

29. In the Available Fields box, double-click the JrnlRow table to open it.  Select 
DistNumber, move it to the Filter Fields box on the right side of the window. Make 
sure DistNumber is selected and select the is equal to parameter from the first drop-
down list. In the second drop-down list box, type 1.

30. When finished, select Next.



The last window, the Template window, lets you overlay your report with a 
predesigned template that can give your report a little additional flair. To familiarize 
yourself with the available templates, click each to preview it. For our current report 
we want a plain format, so we'll stick with the No Template option.

31. Select Finish to see the completed Quotes Good Through report.

Notice that the finished report is displayed on the Preview tab to show what it will 
look like when printed. To achieve the look seen above, you may need to make minor 
adjustments to the column headings. 

32. Finally, select the Save button in the Standard toolbar, and save the report under the 
name “Quotes Good Through List.”

33. Now test your memory. Insert the “Bellwether Garden Supply” company name on 
the report. If you don’t remember how, consult the section of Lesson 2 where we 
discuss putting the company name on a report. Save the report after adding the 
company name.

Filter the Report

Now a bit of fine tuning: we want to add a parameter field, which will make the report 
more useful by limiting the amount of data displayed. The parameter field we want to add 
will filter the GoodThruDate field by a cutoff date so that no quotes with an expiration 
date earlier than the cutoff date will appear on the report.

Note: For more information on using parameter fields, look up "Parameter Fields" in the Crystal Reports Online 
Help index.

Before beginning this exercise, open Bellwether Garden Supply in Peachtree and take 
note of the year. If it is not 2007, please use that year in the lessons below (instead of 
2007).

1. In the Standard toolbar, select the Field Explorer button. 

2. When the Field Explorer window appears, select Parameter Fields and right click. 
From the pop-up menu, select New. 

3. In the Name field, enter “QuoteExpirationDate.”

4. In the Type field, use the drop-down list to select Date.

5. In the Value area of the grid, click where it says "Click here to add item" and enter 
"4/1/2007.



6. In the Value Options grid, change the setting for Prompt Text to "Enter desired 
Quote Good Through Date".

7. Click OK. 

8. Next, we want to create a report selection formula that will filter the report to show 
quotes that fall before the expiration date of April 1, 2007. From the Report menu, 
choose Selection Formulas and then Record.

The Record Selection Formula Editor appears.

9. Place the cursor after the text which reads {JrnlRow.DistNumber} = 1. Type a space 
and then the word "and." Press Enter to go to the next line.

10. In the panel on the left side of the window, double-click the Reports Fields icon to 
open it, and then double-click the JrnlHdr.GoodThruDate field. It will appear as 
part of the selection formula. Type a greater than (>) sign after it.

11. Select the Report Fields icon at the top of the left panel; then find and select 
(double-click) the ?QuoteExpirationDate field. It should appear as part of the 
selection formula, as shown below.



12. The formula is now complete, so select the Save and close button  to 
close the Record Selection Formula Editor.

13. When the Enter Values window appears, select 4/1/2007 from the Please enter a date 
drop-down list. Click OK.

Since we have previously saved the report, a message may appear telling us that 
Crystal has detected a change.

14. If necessary, select the Refresh Data option.

15. Now select the Save button  again to save the final version of our report.
Review of Lesson 3

Let’s review some of the ideas we covered in Lesson 3:

The Standard Report Creation Wizard lets you choose the database, database tables, 
and links that will operate in the report much as you would do if you had started 
with the Database Expert.

The Fields window of the Wizard lets you add fields to the report and also select the 
order of those fields and the column headings that will identify them in the report.



The Grouping window lets you group all information in the report by one or more of 
the chosen fields.

The Summaries window lets you chose a field or fields that will provide summary 
information in the report. It also lets you chosen whether or not to include a grand 
total as part of the summary information.

The Group Sorting window lets you sort groups based on summarized totals. This 
could be useful in the case of reports reflecting information such as sales, where 
you will want to track sales reps or units doing the best business.

The Chart window lets you add a chart to the report, a visual representation of facts 
and figures in the report.

The Report Selection window lets you use one or more of the fields to filter the 
information that appears on the report. This will limit the amount and nature of 
data you see.

The Template window lets you overlay your report with a predesigned template, to 
give your report added flair.

If you want to further limit the data appearing on the report, adding one or more 
parameter fields to the report will be the answer. Go to the Field Explorer, select 
Parameter Fields, right click, and select New.

Appendix 1: Adding Database Information to a Crystal Report

Crystalreports.udl contains field information about your company that you will want to 
include in your Crystal reports. Briefly, here's how you do it: The Crystal Reports 
Database Expert lets you open this file and access the field information contained in its 
data (.DAT) files. On the Database Expert's Links tab, you see the .DAT files listed as a 
series of database tables that you can select and add to your report. 

Once tables are added to the report, the Database Expert's Links tab lets you make 
meaningful connections among the fields contained in them. The reason you link related 
fields across tables is so that the data represented by the fields can match up in useful ways 
within your report. For example, you would probably want to link the 
CustomerRecordNumber field in the JrnlRow database table to the 
CustomerRecordNumber field in the Customer table. This way, transaction information 
for each customer would be credited to the proper customer record in the report.

Finally, with the tables added and their fields properly linked, you're ready to insert the 
field information contained in the tables wherever you want it to appear in your report.

To add linked database information to a Crystal report, follow these steps:



1. Select the Database menu, and then select Database Expert.

The Crystal Database Expert window appears.

2. In the Available Data Sources box, double-click the Create New Connection folder 
to open it.

3. Find and open the OLE DB (ADO) folder by clicking the + sign. This will open the 
OLE DB (ADO) window

4. Select the Use Data Link File checkbox.

5. In the Microsoft Data Link File field, browse to your company folder and select 
Crystalreports.udl.

Note: there may be cases where you will need to select Pervasive PSQL OLE DB Provider in the Provider list 
before you can select Use Data Link File. 

6. Click Next, then Next, and then Finish.

The Database Expert window returns with the contents of the file displayed as a 
series of tables in the Available Data Sources box.



These tables correspond to the Peachtree .DAT files. For example, the Company 
table contains all the company fields present in the COMPANY.DAT file, and the 
Employee table contains all the payroll fields present in EMPLOYEE.DAT.

7. Select as many tables in the list as you want to include in the report. To select a table, 
either highlight it and then click the Right Arrow button, or highlight and double-
click the table.

8. If you want to view or make changes to the way the fields are linked between tables, 
select the Links tab. All the tables you have chosen are displayed at the center of the 
window. If the Smart Linking feature is turned on, the Expert automatically links all 
appropriate fields in the table. You can make new links or dissolve old ones as 
explained in Crystal Reports Online Help; select the Help button in the Database 
Expert window.

9. When finished working in the Database Expert, select OK to close the window.

Now, with the fields in the tables properly linked, you can use the Field Explorer to insert 
database information wherever you want it to appear in your report. For more information, 
look up "Field Explorer" in Crystal Reports Online Help.

Appendix 2: Filtering Crystal Report Data

The Peachtree JrnlRow and JrnlHdr tables are often the primary tables used in 
constructing Crystal custom reports. Certain fields in these tables can help you filter your 
custom reports so that only the data you want is returned in the reports.

In addition, you can use certain fields to filter your reports for information you don’t want 
to see—for example, zero-dollar or void transactions. To do this, you need to edit the 
selection formulas for these included report fields.



Filter Reports Using Specific Fields

The JrnlRow Table

Three fields in the JrnlRow table are especially useful for filtering reports: RowNumber, 
RowType, and Journal.

RowNumber: The RowNumber field is used to order transactions consistently in a report 
and is numbered according to the number of data elements in the individual transaction. 
So you could select RowNumber as the field to link in the JrnlRow table. You could then 
create a selection formula that would tell Crystal which specific row in the transaction to 
draw on. For example, your selection formula might set the value of the RowNumber 
field to zero. The zero value means that the report will draw on the “top-most row,” or 
most basic level of information in the transaction. That translates to the dollar amount 
figure in most transactions, such as customer or vendor invoices. 

To set the value of a field like the RowNumber field, you use either the Crystal Record 
Selection Formula Editor or Select Expert.

1. Open the appropriate report in the Crystal Design window.

2. Do one of the following:

• To open the Record Selection Formula Editor, from the Report menu, choose 
Selection Formulas and then Record. Set the value of the RowNumber field as 
desired.

• To open the Select Expert, from the Report menu, choose Select Expert. You 
will see a JrnlRow.RowNumber tab showing the current value of the 
RowNumber field. Type in a new value, or select it from the drop-down list.

RowType: Similar to RowNumber, the RowType field has a number of valid types, 
including JrnlRowType_Normal, which draws information from basic transactions such 
as invoices, credit memos, and sales orders. 

Journal: The Journal field is very useful since its function is to draw on information in 
the Peachtree journals, such as the General Journal. Below is a table of the valid values for 
this field and the Peachtree journals corresponding to each value.

Value Peachtree Journal

0 General Journal

1 Cash Receipts

2 Cash Disbursements

3 Sales



Just as in the case of the RowNumber field above, you can set the value of the Journal 
field in either the Crystal Record Selection Formula Editor or Select Expert. For example, 
if you set the value of the field to three, then your custom report would draw on the Sales 
Journal for its information.

The JrnlHdr Table

The JrnHdr table, too, has at least one field that will help you filter reports, the 
TransactionDate field. This field will let you make sure the report contains information 
only for a journal transaction that occurred on a specific date. As with other fields 
discussed above, you can change the value of the TransactionDate field in either the 
Record Selection Formula Editor or Select Expert.

Filter Reports to Eliminate Null Values

Oftentimes, you won’t want your Crystal reports loaded with empty bits of information, 
including transaction fields for which there is no dollar total, no date, or no reference 
number of some sort (for example, invoice or purchase order number.) You can do this by 
creating special selection formulas for the fields you use to build your Crystal report.

Null Dates 

For example, suppose you wanted your report to filter out all sales order transactions that 
were lacking a ship-by date. You would set up the report to include the ShipByDate field 
from the JrnlHdr table. Then, in either the Record Selection Formula Editor or Select 
Expert, you would set the value of this field so that the report returned only sales orders 
with non-null ship-by dates. In the Record Selection Formula Editor, the ShipByDate 
field selection formula should look like this:

{JrnlHdr.ShipByDate}<>Date(0,0,0)

The result: The report would include a ship-by date from the original Peachtree 
transaction only if that date were greater or less than 0 month/0 day/0 year—in other 
words, non-null.

4 Purchases

5 Payroll

7 Inventory Adjustments

8 Assemblies

10 Purchase Orders

11 Sales Orders

12 Quotes



Null Currency Amounts

Similarly, if one of your reports lists your company’s inventory items, you could filter out 
all null occurrences of last unit cost. You would do this by including the LastCost field 
from the LineItem table and setting the value of the field so that it would return only non-
null values for the field. In the Record Selection Formula Editor, the LastCost field 
selection formula should look like this:

{JrnlHdr.LastCost}<>0

The result: The report would include a last unit cost from the original Peachtree item 
record only if the cost were greater or less than zero.

Null Strings

You can filter your reports so that transaction fields lacking information don’t show up on 
the report. Let’s say you wanted to filter your report so that a reference number would 
show up only if the original Peachtree transaction had a non-null entry for the number. 
You could do this by selecting the Reference field in the JrnlHdr table and setting it so 
that the report returned only non-null values for transaction reference numbers. In the 
Record Selection Formula Editor, the Reference field selection formula should look this: 

{JrnlHdr.Reference}<>””

The result: The report would include the reference number from the original Peachtree 
transaction only if it was not blank.

In Summary

To filter null Peachtree transaction records out of your Crystal reports, use the following 
values in your report selection formulas:

• Use 0 to filter out missing currency amounts.

• Use Date(0,0,0) to filter out missing dates.

• Use “” to filter out missing string values, such as transaction reference numbers.
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